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 Important Information

Warranty

The CAN hardware for DeviceNet is warranted against defects in materials and workmanship for a period of one year 
from the date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, 
repair or replace equipment that proves to be defective during the warranty period. This warranty includes parts and 
labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming 
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced 
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not 
execute programming instructions if National Instruments receives notice of such defects during the warranty period. 
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside 
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs 
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully reviewed 
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should 
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages 
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. 
Any action against National Instruments must be brought within one year after the cause of action accrues. National 
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty 
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; 
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, 
or other events outside reasonable control.

Copyright

Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, 
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without 
the prior written consent of National Instruments Corporation.

Trademarks

BridgeVIEW™, LabVIEW™, CVI™, Lookout™, natinst.com™, NI-CAN™, and NI-DNET™ are trademarks of National 
Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS

National Instruments products are not designed with components and testing intended to ensure a level of reliability 
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving medical 
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part of the 
user or application designer. Any use or application of National Instruments products for or involving medical or clinical 
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeguards, 
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should always 
continue to be used when National Instruments products are being used. National Instruments products are NOT intended 
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard human health 
and safety in medical or clinical treatment.



 Compliance

FCC/DOC Radio Frequency Interference 
Class A Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance 
with the instructions in this manual, may cause interference to radio and television reception. Classification 
requirements are the same for the Federal Communications Commission (FCC) and the Canadian 
Department of Communications (DOC). This equipment has been tested and found to comply with the 
following two regulatory agencies:

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense.

Notices to User: Changes or modifications not expressly approved by National Instruments could void 
the user’s authority to operate the equipment under the FCC Rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional 
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home 
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government 
Printing Office, Washington, DC 20402.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur 
du Canada.
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About This Manual

This manual contains instructions to help you install and configure the 

National Instruments CAN hardware for DeviceNet and the NI-DNET 

software for Windows NT. The National Instruments CAN hardware for 

DeviceNet supported under Windows NT includes the PCI-CAN and the 

PCMCIA-CAN.

This manual assumes that you are already familiar with Windows NT.

How to Use the Manual Set

Use this getting started manual to install and configure your CAN hardware 

for DeviceNet and the NI-DNET software for Windows NT.

Use the NI-DNET User Manual to learn the basics of DeviceNet and how 

to develop an application program. The user manual also contains detailed 

examples.

NI-DNET
User Manual

Application
Development
and Examples

First-Time
NI-DNET Users

Experienced
NI-DNET Users

NI-DNET
Programmer

Reference Manual

Function
and Object

Descriptions

Getting Started
Manual

Installation and
Configuration
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Use the NI-DNET Programmer Reference Manual for specific information 

about each NI-DNET function and object, including format, parameters, 

and possible errors.

Organization of This Manual

This manual is organized as follows:

• Chapter 1, Introduction, explains how to use this manual, lists what 

you need to get started, provides an overview of the CAN hardware for 

DeviceNet and the NI-DNET software for Windows NT, and describes 

optional equipment you can order.

• Chapter 2, Installation, describes how to install the NI-DNET software 

for Windows NT and the CAN hardware for DeviceNet.

• Chapter 3, Verify the Installation, describes how to verify the hardware 

and software installation and make changes to the configuration.

• Chapter 4, Begin to Use the NI-DNET Software, helps you get started 

with the NI-DNET software for Windows NT.

• Appendix A, Uninstalling the Hardware and Software, describes how 

to uninstall the CAN hardware for DeviceNet and the NI-DNET 

software for Windows NT.

• Appendix B, Cabling Requirements, describes the cabling 

requirements for the hardware.

• Appendix C, Troubleshooting and Common Questions, describes how 

to troubleshoot problems and answers some common questions.

• Appendix D, Specifications, describes the physical characteristics of 

the CAN hardware for DeviceNet and the recommended operating 

conditions.

• Appendix E, Customer Communication, contains forms you can use to 

request help from National Instruments or to comment on our products 

and manuals.

• The Glossary contains an alphabetical list and a description of terms 

used in this manual, including abbreviations, acronyms, metric 

prefixes, mnemonics, and symbols.
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Conventions Used in This Manual

The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options»Substitute 

Fonts directs you to open the File menu, select the Page Setup item, select 

Options, and finally select the Substitute Fonts option from the last dialog 

box.

This icon to the left of bold italicized text denotes a caution, which advises 

you of precautions to take to avoid injury, data loss, or a system crash.

bold Bold text denotes the names of menus, menu items, dialog boxes, dialog 

box buttons or options, icons, windows, Windows NT tabs, or LEDs.

bold italic Bold italic text denotes a caution.

CAN hardware CAN hardware for DeviceNet refers to the PCI-CAN and PCMCIA-CAN 

for DeviceNet in cases where the material applies to both cards.

italic Italic text denotes emphasis, a cross reference, or an introduction to a key 

concept. This font also denotes text for which you supply the appropriate 

word or value, such as in Windows 3.x.

monospace Text in this font denotes text or characters that you should literally enter 

from the keyboard, sections of code, programming examples, and syntax 

examples. This font is also used for the proper names of disk drives, paths, 

directories, programs, subprograms, subroutines, device names, functions, 

parameters, operations, variables, filenames, and extensions, and for 

statements and comments taken from program code.

monospace italic Italic text in this font denotes that you must supply the appropriate words 

or values in the place of these items.

paths Paths in this manual are denoted using backslashes (\) to separate drive 

names, directories, folders, and files.

Related Documentation

The following documents contain information that you may find helpful as 

you read this manual:

• CiA Draft Standard 102, Version 2.0, CAN Physical Layer for 

Industrial Applications

!
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• DeviceNet Specification, Version 2.0, Open DeviceNet Vendor 

Association

• Microsoft Windows NT User’s Guide, Microsoft Corporation

• PC Card Standard, Release 2.1, Personal Computer Memory Card 

International Association (PCMCIA)

• PCI Local Bus Specification, Revision 2.0, PCI Special Interest Group

Customer Communication

National Instruments wants to receive your comments on our products 

and manuals. We are interested in the applications you develop with our 

products, and we want to help if you have problems with them. To make it 

easy for you to contact us, this manual contains comment and configuration 

forms for you to complete. These forms are in Appendix E, Customer 

Communication, at the end of this manual. 
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1
Introduction

This chapter explains how to use this manual, lists what you need to get 

started, provides an overview of the CAN hardware for DeviceNet and the 

NI-DNET software for Windows NT, and describes optional equipment 

you can order.

How to Use This Manual
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No

Chapter 3
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Chapter 2
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What You Need to Get Started

Make sure you have all of the following items before you attempt to install 

the hardware and software:

❑ Windows NT 3.51 or later installed on your computer

❑ One of the following cards, which is included in your kit:

PCI-CAN

PCMCIA-CAN

❑ The following 3.5 in., high-density (1.44 MB) disks, which are 

included in your kit:

NI-DNET Software for Windows 95/98 and Windows NT (Disk 1 of 3)

NI-DNET Software for Windows 95/98 and Windows NT (Disk 2 of 3)

NI-DNET Software for Windows 95/98 and Windows NT (Disk 3 of 3)

❑ PCMCIA-CAN bus-powered cable, which is included in your kit if 

you have a PCMCIA-CAN

❑ DeviceNet interface cables that meet the requirements in Appendix B, 

Cabling Requirements

DeviceNet Hardware Overview

The National Instruments CAN hardware for DeviceNet supported under 

Windows NT includes the PCI-CAN and PCMCIA-CAN.

The PCI-CAN is software configurable and compliant with the PCI Local 

Bus Specification. With a PCI-CAN, you can make your PC-compatible 

computer with PCI Local Bus slots communicate with and control 

DeviceNet devices.

The PCMCIA-CAN is a Type II PC Card that is software configurable and 

compliant with the PCMCIA standards for 16-bit PC Cards. With a 

PCMCIA-CAN, you can make your PC-compatible notebook with 

PCMCIA sockets communicate with and control DeviceNet devices.

The PCI-CAN or PCMCIA-CAN in your kit is fully compliant with the 

DeviceNet Specification.

The DeviceNet physical communication link protocol is based on the 

Controller Area Network (CAN) protocol. The physical layers of the 
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PCI-CAN and PCMCIA-CAN fully conform to the DeviceNet physical 

layer requirements. The physical layer is optically isolated to 500 volts and 

is powered from the DeviceNet bus power supply. DeviceNet interfacing is 

accomplished using the Intel 82527 CAN controller chip. For more 

information on the DeviceNet physical layer and cables used to connect to 

your DeviceNet devices, see Appendix B, Cabling Requirements.

The PCI-CAN is available with two physical connector types: 

• Combicon-style pluggable screw terminals (as required by the 

DeviceNet Specification) 

• DB-9 D-Sub (for non-DeviceNet applications)

The PCMCIA-CAN is shipped with a cable that is fully DeviceNet 

compliant. PCMCIA-CAN cards are also available with a cable that powers 

the CAN physical layer from the card. 

All of the CAN hardware for DeviceNet uses the Intel 386EX embedded 

processor to implement time-critical features provided by the NI-DNET 

software. The cards communicate with the NI-DNET driver through 

on-board shared memory and an interrupt.

NI-DNET Software Overview

The NI-DNET software includes a native, 32-bit multitasking 

Windows NT kernel driver.

The NI-DNET software for Windows NT supports the concurrent use of 

multiple National Instruments DeviceNet cards. For example, you can use 

both a PCI-CAN and PCMCIA-CAN in the same system at the same time. 

The NI-DNET software is fully integrated into the Windows NT operating 

system.

The NI-DNET software, along with the CAN hardware for DeviceNet, 

transforms your computer into a DeviceNet interface with complete 

communications and bus management capability. The NI-DNET software 

can act as a DeviceNet master in order to communicate with up to 63 slave 

devices. Communication capabilities include explicit messaging, 

polled I/O, strobed I/O, and change-of-state/cyclic I/O. The NI-DNET 

software can also act as a DeviceNet slave.
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The NI-DNET software includes the following components:

• Firmware (runs on embedded Intel 386EX)

• Device driver

• Hardware Configuration utility

• Language interface libraries for Microsoft Visual C/C++ 2.0 or later, 

Borland C/C++ 5.0 or later, LabWindows/CVI 4.0 or later, and 

LabVIEW 4.0 or later

• Example programs that use NI-DNET functions

• WinDnet support files

The NI-DNET software components are described in more detail in 

Chapter 1, Introduction, of the NI-DNET User Manual.

Optional Programming Tools

Your kit includes the NI-DNET software for Windows NT. In addition, 

you can order the LabWindows/CVI, LabVIEW, BridgeVIEW, or Lookout 

software from National Instruments.

LabWindows/CVI is an interactive ANSI C development environment for 

building test and measurement and instrument control systems. It includes 

interactive code-generation tools and a graphical editor for building custom 

user interfaces. It also includes built-in libraries for IEEE 488.2, VXI, 

RS-232 control, and plug-in data acquisition. When you order 

LabWindows/CVI, you also get hundreds of complete instrument drivers, 

which are modular, source-code programs that handle the communication 

with your instrument so that you do not have to learn the programming 

details.

LabVIEW is a complete programming environment that departs from the 

sequential nature of traditional programming languages and features a 

graphical programming environment. It includes all the tools needed for 

instrument control, data acquisition, analysis, and presentation. LabVIEW 

also includes an extensive instrument driver library.

BridgeVIEW is a radical departure from traditional automation software 

that provides a flexible program development system for a variety of 

DeviceNet applications including general manufacturing, test, and control. 

Leveraging National Instruments’ patented graphical programming 

language G (otherwise known as LabVIEW), BridgeVIEW gives you the 

ability to integrate functionality in a way that is not possible with traditional 

automation software. In addition to the programming advantages of G, 
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BridgeVIEW also provides a number of powerful features for the 

development of your industrial automation application: graphical HMI 

(Human Machine Interface); ease of use; fill-in-the-blank configuration 

utilities; HMI G Wizard for simplified HMI development; historical data 

collection and trending; alarm and event reporting and logging; security; 

and connectivity to PLCs and industrial device networks like DeviceNet.

Lookout is a software package that gives users an object-oriented, 

event-driven environment for building a variety of applications including 

HMI, large supervisory control and data acquisition (SCADA) 

applications, discrete manufacturing, batch applications, and telemetry 

systems. Lookout utilizes a graphical interface and requires no 

programming or scripting. Lookout’s unique object-oriented approach 

increases productivity while reducing engineering design and maintenance 

costs. Unlike products that offer graphical user interfaces objects, Lookout 

is actually object-oriented in all aspects of system development. With 

Lookout, tasks such as driver setup, database configuration, historical 

logging, security management, and more are combined into a single, 

integrated system. 

For more information about LabWindows/CVI, LabVIEW, BridgeVIEW, 

and Lookout, contact National Instruments.
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2
Installation

This chapter describes how to install the NI-DNET software for 

Windows NT and the CAN hardware for DeviceNet.

Install the NI-DNET Software

Install the NI-DNET software for Windows NT before you install the 

hardware.

Installation for Windows NT 3.51

1. Log onto your Windows NT system using the Administrator 

account. The NI-DNET setup program must have Administrator 

privileges because the program modifies the configuration registry of 

your system.

2. Insert the NI-DNET Software for Windows 95/98 and Windows NT 

(Disk 1 of 3) into an unused drive.

3. In the Run dialog box, type the following:

x:\setup

where x is the letter of the drive containing the disk (usually a or b).
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4. The software installation wizard begins with the screen shown in 

Figure 2-1.

Figure 2-1.  NI-DNET Software Setup Screen

The setup wizard guides you through the necessary steps to install 

the NI-DNET software. You may go back and change values where 

appropriate by clicking on the Back button. You can exit the setup 

where appropriate by clicking on the Cancel button.

5. Shut down Windows NT and turn off your computer when you 

complete the setup.

6. Proceed to the next section, Install the Hardware.

Installation for Windows NT 4.0

1. Log onto your Windows NT system using the Administrator 

account. The NI-DNET setup program must have Administrator 

privileges because the program modifies the configuration registry of 

your system.

2. Select Start»Settings»Control Panel.
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3. Double-click on the Add/Remove Programs icon in the Control Panel 

to launch the Add/Remove Programs applet. A dialog box similar to 

the one in Figure 2-2 appears.

Figure 2-2.  Add/Remove Programs Properties Dialog Box

4. Click on the Install button.

5. When prompted, insert the NI-DNET Software for Windows 95/98 and 

Windows NT (Disk 1 of 3), and click on the Next button to proceed. 
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The software installation wizard begins with the screen shown in 

Figure 2-3.

Figure 2-3.  NI-DNET Software Setup Screen

The setup wizard guides you through the necessary steps to install 

the NI-DNET software. You may go back and change values where 

appropriate by clicking on the Back button. If at any time you want to 

exit the setup, click on the Cancel button.

6. Shut down Windows NT and turn off your computer when you 

complete the setup.

7. Proceed to the next section, Install the Hardware.
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Install the Hardware

This section describes how to install your CAN hardware for DeviceNet.

Install Your PCI-CAN

Caution Before you remove the card from the package, touch the antistatic plastic package 

to a metal part of your system chassis to discharge electrostatic energy, which can 

damage several components on your card.

1. Make sure your computer is turned off. Keep the computer plugged in 

so that it remains grounded while you install the card.

2. Remove the top cover (or other access panels) to give yourself access 

to the computer expansion slots.

3. Find an unused PCI expansion slot in your computer.

4. Remove the corresponding slot cover on the back panel of the 

computer.

5. If you plan to use your PCI-CAN in a non DeviceNet-compliant 

system where bus power is not available, you need to configure the 

power supply jumpers. See Appendix B, Cabling Requirements, for 

more information.

6. Insert the PCI-CAN into the slot with the DeviceNet connector 

sticking out of the opening on the back panel. It might be a tight fit, but 

do not force the card into place. Figure 2-4 shows how to install the 

PCI-CAN into a PCI expansion slot.

!
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Figure 2-4.  Installing the PCI-CAN

7. Screw the mounting bracket of the PCI-CAN to the back panel rail of 

the computer.

8. Replace the top cover (or the access panel to the expansion slot).

9. Turn on your computer and start Windows NT.

Connect the Cables
After you have installed your card, connect the DeviceNet cables to your 

PCI-CAN DeviceNet connector. Because exact cabling requirements vary 

for each application, National Instruments does not provide DeviceNet 

cables. Refer to Appendix B, Cabling Requirements, for information about 

the cabling requirements of the hardware.

The PCI-CAN installation is now complete. Proceed to Chapter 3, Verify 

the Installation, to verify that your hardware and software installed 

correctly.
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Install Your PCMCIA-CAN

Caution Before you remove the card from the package, touch the antistatic plastic package 

to a metal part of your system chassis to discharge electrostatic energy, which can 

damage several components on your card.

1. Shut down Windows NT and power off your computer.

2. Insert the PCMCIA-CAN into a free PC Card (PCMCIA) socket. The 

card has no jumpers or switches to set.

3. Connect the PCMCIA-CAN bus-powered cable to the card. Figure 2-5 

shows how to insert the card and how to connect the PCMCIA-CAN 

bus-powered cable to the card.

Figure 2-5.  Inserting the PCMCIA-CAN

4. Power on your computer.

When you have finished installing the hardware, proceed to the next 

section, Connect the Cables.

!

PCMCIA-CAN
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Connect the Cables
After you have installed the card, connect your DeviceNet cables to the 

PCMCIA-CAN bus-powered cable. Because exact cabling requirements 

vary for each application, National Instruments does not provide 

DeviceNet cables. Refer to Appendix B, Cabling Requirements, 

for information about the cabling requirements of the hardware.

The PCMCIA-CAN installation is now complete. Proceed to Chapter 3, 

Verify the Installation, to verify that your hardware and software installed 

correctly.



© National Instruments Corporation 3-1 Getting Started with DeviceNet for Windows NT

3
Verify the Installation

This chapter describes how to verify the hardware and software installation 

and make changes to the configuration.

Run the NI-DNET Hardware Configuration Utility

You can use the NI-DNET Hardware Configuration utility, installed with 

your NI-DNET software, to test the hardware and software installation. The 

utility verifies that your hardware and software are functioning properly 

and that the configuration of your hardware does not conflict with anything 

else in your system.

To use the NI-DNET Hardware Configuration utility, you must first log in 

as Administrator or as a user with Administrator privileges.

To run the Hardware Configuration utility under Windows NT 4.0, select 

the Hardware Configuration item under Start»Programs»NI-DNET 

Software.

To run the Hardware Configuration utility under Windows NT 3.51, select 

the Hardware Configuration item in the NI-DNET Software program 

group.

Verify Resources
When you install a PCI-CAN, your computer automatically assigns valid 

resources to it. Because this resource assignment is automatic, you can 

verify the installation immediately.

When you install a PCMCIA-CAN, your computer assigns default 

resources to it. Because the default resources may conflict with other 

hardware in your system, you must double-click on PCMCIA-CAN 

card’s name, then use the Resources tab to select valid resources for 
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the PCMCIA-CAN. Figure 3-1 shows the Resources tab for the 

PCMCIA-CAN.

Figure 3-1.  PCMCIA-CAN Resources Tab

If the PCMCIA-CAN resources do not conflict with other hardware in your 

system, select OK and exit the NI-DNET Hardware Configuration utility. 

If the PCMCIA-CAN resources are not valid, select valid resources and exit 

the NI-DNET Hardware Configuration utility. After you verify 

PCMCIA-CAN resources, you must restart Windows NT. You can then 

restart the NI-DNET Hardware Configuration utility to proceed with 

verifying the installation.

Test Installed DeviceNet Ports
The main listing of the NI-DNET Hardware Configuration utility displays 

each installed PCI-CAN or PCMCIA-CAN card. If you have physically 

installed your card but it is not listed in the NI-DNET Hardware 

Configuration utility, refer to the Missing Card in the NI-DNET Hardware 

Configuration Utility section in Appendix C, Troubleshooting and 

Common Questions.

To view information about a card’s physical DeviceNet ports, click on the 

plus sign next to the card’s name in the list. Since the NI-DNET software 

supports only single port hardware, the utility displays Port 1 for each card.
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To run a hardware and software diagnostic test for all installed DeviceNet 

ports, select Test All from the Test menu. A progress bar displays the 

progression of the diagnostic test. When the diagnostic tests are complete, 

a checkmark next to a DeviceNet port indicates successful diagnostic 

testing, and an X indicates failure.

Figure 3-2 shows the NI-DNET Hardware Configuration utility after it has 

tested two cards.

Figure 3-2.  NI-DNET Hardware Configuration Utility after Testing

If each installed DeviceNet port is shown with a checkmark, you are ready 

to use the NI-DNET software. Select Exit from the File menu and proceed 

to Chapter 4, Begin to Use the NI-DNET Software.

If the diagnostic test fails for any port, you can see information on the 

failure by selecting the failed port name in the list then double-clicking on 

the Status field to the right. Use that help text and the information in 

Appendix C, Troubleshooting and Common Questions, to troubleshoot the 

problem.

After you have resolved a diagnostic failure for a particular DeviceNet port, 

you can test that port again by selecting it from the list then selecting Test 

One from the Test menu.

If you want to refresh the diagnostic status of all DeviceNet ports in order 

to run the diagnostic tests again, select Refresh from the View menu. 
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Changing an Interface Name
When you select a DeviceNet port in the list, the Interface Name for that 

port is shown to the right. This NI-DNET interface name is used within 

your application as a reference to the selected DeviceNet port. For a single 

card, the default NI-DNET interface name is DNET0.

If you want to change the NI-DNET interface name associated with a port, 

double-click on the port name. The resulting dialog box provides an 

Interface Name drop-down box you can use to select DNET0, DNET1, 

and so on. Changing the NI-DNET interface name is normally done only 

when you have multiple cards in your system. For example, if you have two 

PCI-CAN cards installed, you would normally assign one card as DNET0 

and the other as DNET1.

Figure 3-3 shows the dialog box used to change a port’s NI-DNET interface 

name.

Figure 3-3.  Interface Name Change Dialog Box
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4
Begin to Use the 
NI-DNET Software

This chapter helps you get started with the NI-DNET software for 

Windows NT.

NI-DNET Application Example

The section introduces you to the NI-DNET software using 

SingleDevice, an example that accomplishes I/O communication as a 

DeviceNet master with a single slave device.

SingleDevice
This example accomplishes I/O communication as a DeviceNet master 

with a single slave device. You can use this example with any type of 

DeviceNet slave device. This example should be a starting point for you to 

learn to use the NI-DNET software.

The LabVIEW front panel for this example is shown in Figure 4-1. The 

LabWindows/CVI front panel is similar.
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Figure 4-1.  SingleDevice Front Panel

Run the Example
Follow these steps to run the example:

1. Connect a single DeviceNet slave device to your DeviceNet interface. 

For information on DeviceNet cabling, refer to Appendix B, Cabling 

Requirements.

2. Determine the baud rate and MAC ID used by your slave device.

Many devices provide external switches for the MAC ID and baud rate. 

If this is the case, consult the documentation provided by your device’s 

vendor.
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If your device does not have baud rate and MAC ID external switches, 

the baud rate is often fixed at 125,000 (or determined by the device 

automatically), and the MAC ID is configured using a network 

management utility. For information on network management utilities, 

refer to Chapter 3, NI-DNET Programming Techniques, in the 

NI-DNET User Manual.

If you know the baud rate of your device but not the MAC ID, 

NI-DNET provides a utility used to tell you the MAC ID of each 

connected device (SimpleWho). For information on SimpleWho, refer 

to Chapter 3, NI-DNET Programming Techniques, in the NI-DNET 

User Manual.

3. Determine the type of I/O communication supported by your 

DeviceNet device. For example, most photoelectric sensors support 

strobed I/O with an input length of 1 byte. You need to know the 

I/O connection type (poll, strobe, and so on), number of input bytes, 

and number of output bytes.

This information should be included in the documentation provided by 

your device’s vendor. If not, you can use the SimpleWho utility 

mentioned in Step 2 to find the information.

4. Load SingleDevice into your programming environment.

• LabVIEW or BridgeVIEW: Select File»Open, then find 

SingleDevice.vi in the LabVIEW or BridgeVIEW Examples 

directory.

• LabWindows/CVI: Select File»Open»Project, then find 

SingleDevice.prj in the LabWindows/CVI Samples 

directory.

• For other programming environments, such as Microsoft C/C++, 

you can open SingleDevice.c in the NI-DNET Examples 

directory. Since the steps needed to edit, compile, and run 

SingleDevice.c are specific to your programming 

environment, the following steps provide information only for 

LabVIEW, BridgeVIEW, or LabWindows/CVI.

5. Change the front panel controls to match the capabilities of your slave 

device.

For LabVIEW or BridgeVIEW, you must change the front panel 

controls prior to running the example.

For LabWindows/CVI, you must first run the example in order to 

access the front panel controls.
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• Interface Name: This name selects the DeviceNet interface to 

use. If you only have one National Instruments DeviceNet card 

installed, the default DNET0 is appropriate.

• Interface MAC ID: This selects the DeviceNet MAC ID to use 

for your National Instruments DeviceNet card (it does not refer to 

a device). If you do not know of an unused MAC ID in your 

network, a MAC ID of 0 is often acceptable.

• Baud Rate: This selects the baud rate used by your DeviceNet 

device. Enter the value you determined in Step 2.

• Poll Mode: Leave this control set to Automatic.

• Device MAC ID: This selects the MAC ID of your DeviceNet 

device. Enter the value you determined in Step 2.

• Connection Type: This selects the type of I/O connection to use 

with your DeviceNet device. Enter the value you determined in 

Step 3.

• Input Length: This selects the number of bytes to read from the 

device’s I/O connection. Enter the value you determined in Step 3.

• Output Length: This selects the number of bytes to write to the 

device’s I/O connection. Enter the value you determined in Step 3.

• Exp Packet Rate: This determines the rate of I/O communication. 

Since you set Poll Mode to Automatic, if you specified a 

Connection Type of Strobe or Poll, then this rate is determined 

automatically by NI-DNET, and the value in this control is 

ignored (you can leave it zero). If you specified a Connection 

Type of COS, set this control to 10000. If you specified a 

Connection Type of Cyclic, set this control to 100.

6. Start I/O communication.

For LabVIEW or BridgeVIEW, click on the Run button (right arrow) 

on the LabVIEW/BridgeVIEW menu bar to run the example.

For LabWindows/CVI, click on the Start button on the example’s front 

panel.

After you start I/O communication, you can view the slave’s input 

bytes on the front panel Input Data indicators, and you can enter new 

output bytes using the front panel Output Data controls. You can use 

these input and output bytes to test and manipulate the physical 

capabilities of your slave device.
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7. Stop the example.

For LabVIEW or BridgeVIEW, click on the Stop button on the 

example’s front panel. If needed, you can still view any errors or other 

information on the front panel.

For LabWindows/CVI, click on the Stop button on the example’s front 

panel. Although I/O communication has stopped, you can still view 

any errors or other information on the front panel. Click on the Exit 

button to close the front panel and exit back to the LabWindows/CVI 

environment.

Congratulations on completing your first DeviceNet application! For more 

information about the SingleDevice example, including a program flow 

chart for the example’s source code, refer to Chapter 4, Application 

Examples, in the NI-DNET User Manual.

General Programming Considerations

As you begin developing your NI-DNET application, remember the 

following points:

• For your LabVIEW or BridgeVIEW application, you must use the 

NI-DNET LabVIEW functions. The NI-DNET functions can be added 

to your LabVIEW palettes by selecting Edit»Select Palette 

Set»nidnet_view from within LabVIEW.

• For LabWindows/CVI applications, you must use the NI-DNET 

function panels for LabWindows/CVI. These function panels can be 

used by selecting Libraries»NI-DNET from within 

LabWindows/CVI.

• For your C/C++ application, you must include the NI-DNET header 

file, nidnet.h, in your source code.

• Use the DeviceNet examples included with the NI-DNET software as 

a guide for your own application development.

For information about developing your application, refer to the NI-DNET 

User Manual. For detailed information about NI-DNET functions and 

objects, refer to the NI-DNET Programer Reference Manual.
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A
Uninstalling the Hardware 
and Software

This appendix describes how to uninstall the CAN hardware for DeviceNet 

and the NI-DNET software for Windows NT.

Uninstalling the Hardware from Windows NT

Because the current version of Windows NT does not maintain hardware 

information for the card, you just need to physically remove the card from 

your computer. To do so, shut down Windows NT, power off your 

computer, remove any cables attached to your card, and physically remove 

the card from your computer.

Uninstalling the NI-DNET Software from Windows NT

Before uninstalling the NI-DNET software, you should remove all CAN 

hardware for DeviceNet from your computer, as explained in the previous 

section.

To uninstall the NI-DNET software for Windows NT, you must first log in 

as Administrator or as a user who has Administrator privileges.

Uninstalling for Windows NT 3.51
Complete the following steps to remove the NI-DNET software from 

Windows NT 3.51:

1. Open the program group NI-DNET Software.

2. Double-click on the Uninstall icon.
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3. The uninstall program runs and removes all folders, utilities, device 

drivers, DLLs, and registry entries associated with the NI-DNET 

software. Figure A-1 shows the results of a successful uninstallation.

Figure A-1.  NI-DNET Uninstallation Results
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Uninstalling for Windows NT 4.0
Complete the following steps to remove the NI-DNET software from 

Windows NT 4.0:

1. Select the Add/Remove Programs icon under Start»Settings» 

Control Panel. A dialog box similar to the one in Figure A-2 appears. 

This dialog box lists the software available for removal.

Figure A-2.  Add/Remove Programs Properties Dialog Box

2. Select the NI-DNET software you want to remove and click on the 

Add/Remove button. The uninstall program runs and removes all 

folders, utilities, device drivers, DLLs, and registry entries associated 
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with the NI-DNET software. Figure A-3 shows the results of a 

successful uninstallation.

Figure A-3.  NI-DNET Uninstallation Results

The uninstall program removes only items that the installation program 

installed. If you add anything to a directory that was created by the 

installation program, the uninstall program does not delete that directory 

because the directory is not empty after the uninstallation. You need to 

remove any remaining components yourself.

If you want to reinstall the hardware and software, refer to Chapter 2, 

Installation.
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B
Cabling Requirements

This appendix describes the cabling requirements for the hardware. 

Cables should be constructed to meet these requirements as well as the 

requirements of DeviceNet. DeviceNet cabling requirements can be found 

in the DeviceNet Specification.

Connector Pinouts

The PCI-CAN (Combicon) and the PCMCIA-CAN bus-powered cable 

each have a Combicon-style pluggable screw terminal connector. The 

PCMCIA-CAN bus-powered cable also has a DB-9 D-Sub connector.

The 5-pin Combicon-style pluggable screw terminal follows the pinout 

required by the DeviceNet Specification. Figure B-1 shows the pinout for 

this connector. 

Figure B-1.  Pinout for 5-Pin Combicon-Style Pluggable Screw Terminal

CAN_H and CAN_L are signal lines that carry the data on the DeviceNet 

network. These signals should be connected using twisted-pair cable.

For the PCI-CAN and the PCMCIA-CAN bus-powered cable, V+ and V– 

supply power to the DeviceNet physical layer. See the next section, Power 

Supply Information for the DeviceNet Ports, for more information.

Figure B-2 shows the end of a PCMCIA-CAN bus-powered cable. The 

arrow points to pin 1 of the 5-pin screw terminal block. All of the signals 

on the 5-pin Combicon-style pluggable screw terminal are connected 
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directly to the corresponding pins on the 9-pin D-Sub following the pinout 

in Figure B-3.

Figure B-2.  PCMCIA-CAN Bus-Powered Cable

The 9-pin D-Sub follows the pinout recommended by CiA Draft 

Standard 102. Figure B-3 shows the pinout for this connector.

Figure B-3.  Pinout for 9-Pin D-Sub Connector
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Power Supply Information for the DeviceNet Ports

For the PCI-CAN and the PCMCIA-CAN bus-powered cable, the bus must 

supply power to each DeviceNet port. The bus power supply should be a 

DC power supply with an output of 10 V to 30 V. The DeviceNet physical 

layer is powered from the bus using the V+ and V– lines. 

The power requirements for the DeviceNet port are shown in Table B-1. 

You should take these requirements into account when determining the 

requirements of the bus power supply for the system.

For the PCI-CAN, a jumper controls the source of power for the DeviceNet 

physical layer. The location of this jumper is shown in Figure B-4.

Figure B-4.  PCI-CAN Power Source Jumper

Table B-1.  Power Requirements for the DeviceNet Physical Layer

for Bus-Powered Versions

Characteristic Specification

Voltage Requirement V+ 10 to 30 VDC

Current Requirement 40 mA typical 

100 mA maximum

1 Power Supply Jumper J6
2 Product Name

3 Serial Number
4 Assembly Number

1
2

3

4
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The PCI-CAN is shipped with this jumper set in the EXT position. In this 

position, the physical layer is powered from the bus (the V+ and V– pins on 

the Combicon connector). The jumper must be in this position for the 

DeviceNet interface to be compliant with the DeviceNet Specification. 

If the DeviceNet interface is being used in a system where bus power is not 

available, the jumper may be set in the INT position. In this position, the 

physical layer is powered by the host computer or internally. The physical 

layer is still optically isolated. Figure B-5 shows how to configure your 

jumpers for internal or external power supplies.

Figure B-5.  Power Source Jumpers

The PCMCIA-CAN is shipped with the bus power version of the 

PCMCIA-CAN cable. An internally-powered version of the 

PCMCIA-CAN cable can be ordered from National Instruments.

Cable Specifications

Cables should meet the requirements of the DeviceNet cable specification. 

DeviceNet cabling requirements can be found in the DeviceNet 

Specification.

Belden cable (3084A) meets all of those requirements and should be 

suitable for most applications.

Cable Lengths

The allowable cable length is affected by the characteristics of the cabling 

and the desired bit transmission rates. Detailed cable length requirements 

can be found in the DeviceNet Specification.

INT EXT

a. Internal Power Mode

INT EXT

b. External Power Mode
(DeviceNet)

123 123
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Table B-2 lists the DeviceNet cable length specifications.

Maximum Number of Devices

The maximum number of devices that you can connect to a DeviceNet port 

depends on the electrical characteristics of the devices on the network. If all 

of the devices on the network meet the DeviceNet specifications, 64 devices 

may be connected to the network.

Cable Termination

The pair of signal wires (CAN_H and CAN_L) constitutes a transmission 

line. If the transmission line is not terminated, each signal change on the 

line causes reflections that may cause communication failures.

Because communication flows both ways on the DeviceNet bus, DeviceNet 

requires that both ends of the cable be terminated. However, this 

requirement does not mean that every device should have a termination 

resistor. If multiple devices are placed along the cable, only the devices on 

the ends of the cable should have termination resistors. See Figure B-6 for 

an example of where termination resistors should be placed in a system 

with more than two devices.

Figure B-6.  Termination Resistor Placement

Table B-2.  DeviceNet Cable Length Specifications

Baud Rate Trunk Length

Drop Length 

Maximum

Drop Length 

Cumulative

500 kb/s 100 m (328 ft.) 6 m (20 ft.) 39 m (128 ft.)

250 kb/s 250 m (820 ft.) 6 m (20 ft.) 78 m (256 ft.)

125 kb/s 500 m (1640 ft.) 6 m (20 ft.) 156 m (512 ft.)

120Ω  120Ω  

CAN_H

CAN_L

DeviceNet
Device

DeviceNet
Device

DeviceNet
Device

DeviceNet
Device
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The termination resistors on a cable should match the nominal impedance 

of the cable. DeviceNet requires a cable with a nominal impedance of 

120 Ω; therefore, a 120 Ω resistor should be used at each end of the cable. 

Each termination resistor should each be capable of dissipating at least 

0.25 W of power.

Cabling Example

Figure B-7 shows an example of a cable to connect two DeviceNet devices. 

Figure B-7.  Cabling Example
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C
Troubleshooting and 
Common Questions

This appendix describes how to troubleshoot problems and answers some 

common questions.

Hardware Configuration Utility Failures

The following sections explain common error messages generated by the 

NI-DNET Hardware Configuration utility.

Resource Error
This error occurs if the memory resource or interrupt resource assigned to 

a card conflicts with the resources being used by other hardware in the 

system. If a resource error occurs, double-click on the card name in the 

NI-DNET Hardware Configuration utility to view the resources. For the 

PCMCIA-CAN, change the conflicting resource shown in Resources until 

the card passes the diagnostic test. For the PCI-CAN, if legacy hardware in 

your system is using the resources, change the resource configuration of the 

legacy hardware (if you need help, refer to the documentation that came 

with your hardware). After you select valid resources, you must exit the 

Hardware Configuration utility and restart Windows NT for the changes to 

take effect. If the problem persists, contact National Instruments.

NI-DNET Software Problem Encountered
This error occurs if the NI-DNET Hardware Configuration utility detects 

that it is unable to communicate correctly with the card using the installed 

NI-DNET software. If you get this error, shut down your computer, restart 

it, and run the NI-DNET Hardware Configuration utility again. If the 

problem persists, try reinstalling the NI-DNET software for Windows NT. 

Missing Card in the NI-DNET Hardware Configuration Utility
If your card is not listed in the NI-DNET Hardware Configuration utility, 

the card is not properly installed. For CAN hardware for DeviceNet, this 

means that your card is not physically present in the system. If your card is 
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firmly plugged into its slot and the problem persists, contact National 

Instruments.

Hardware Problem Encountered
This error occurs if the NI-DNET Hardware Configuration utility detects a 

defect in the hardware. If you get this error, write down the numeric code 

shown with the error and contact National Instruments. Depending on the 

cause of the hardware failure, you may need to repair or replace your card.

Common Questions

How can I determine which version of the NI-DNET software I have 

installed?

Run the NI-DNET Hardware Configuration utility. To run the utility, select 

the Hardware Configuration item under Start»Programs»NI-DNET 

Software, and select the About item under the Help menu. The NI-DNET 

utility displays information about the version of the NI-DNET software 

currently installed.

Which CAN hardware for DeviceNet does the NI-DNET software for 

Windows NT support?

The NI-DNET software for Windows NT supports the PCI-CAN and 

PCMCIA-CAN. Although the PCI-CAN/2 works with NI-DNET, only 

port 1 can be used. Port 2 cannot be used with NI-DNET.

Does NI-DNET support two-port CAN cards?

No. Refer to the previous question.

How many cards can I configure for use with my NI-DNET software 

for Windows NT? 

The NI-DNET software for Windows NT can be configured to 

communicate with up to 10 cards. 

How do I connect a DeviceNet device to my DeviceNet port?

You need a DeviceNet-compliant cable. For information about cabling 

requirements for National Instruments DeviceNet ports, refer to 

Appendix B, Cabling Requirements.
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What do I do if the NI-DNET Hardware Configuration utility test fails 

with an error?

Refer to the Hardware Configuration Utility Failures section in this 

appendix for specific information about what might cause the NI-DNET 

Hardware Configuration utility to fail. If you have already completed the 

troubleshooting steps, fill out the forms in Appendix E, Customer 

Communication, and contact National Instruments.

Are interrupts required for the CAN hardware for DeviceNet?

Yes, one interrupt per card is required. You can set interrupts using the 

Resources tab of the Hardware Configuration utility.

How do I use NI-DNET within my programming environment?

For information about using NI-DNET from within LabVIEW, 

BridgeVIEW, LabWindows/CVI, Microsoft C, and other programming 

environments, refer to the NI-DNET User Manual.

Why does the uninstall program leave some components installed?

The uninstall program removes only items that the installation program 

installed. If you add anything to a directory that was created by the 

installation program, the uninstall program does not delete that directory 

because the directory is not empty after the uninstallation. You must 

remove any remaining components yourself.

How can I monitor low-level CAN messages on a DeviceNet network?

You can use your CAN hardware for DeviceNet with National Instruments 

NI-CAN software. The NI-CAN software is suited to general purpose CAN 

applications, such as automotive tests, and can receive all CAN messages 

on a DeviceNet network. Using NI-CAN for this purpose generally requires 

a detailed knowledge of the DeviceNet Specification. For more information 

on NI-CAN, refer to the README.TXT file in your NI-DNET installation 

directory.

What is NI-CAN?

NI-CAN is National Instruments software for general-purpose access to 

Controller Area Network (CAN). CAN is the underlying communications 

protocol used by DeviceNet. Unless you have a detailed knowledge of the 

DeviceNet Specification and you need to implement portions of that 

specification within your application, NI-DNET is the preferable method 
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for accessing a DeviceNet network. For more information on NI-CAN, 

refer to the README.TXT file in your NI-DNET installation directory.

What information should I have before I call National Instruments?

When you call National Instruments, you should have all of the information 

filled out on the Hardware and Software Configuration Form in 

Appendix E, Customer Communication.
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D
Specifications

This appendix describes the physical characteristics of the CAN hardware 

for DeviceNet and the recommended operating conditions.

Table D-1.  PCI-CAN Characteristics

Characteristic Specification

Dimensions 10.67 by 17.46 cm

(4.2 by 6.88 in.)

Power Requirement +5 VDC 775 mA typical

I/O Connector 5-pin Combicon-style pluggable 

DeviceNet screw terminal

Operating Environment

Ambient Temperature

Relative Humidity

0° to 55° C

10% to 90%, noncondensing

Storage Environment

Temperature

Relative Humidity

–20° to 70° C

5% to 90%, noncondensing

EMI FCC Class A Verified
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Table D-2.  PCMCIA-CAN Characteristics

Characteristic Specification

Dimensions 8.56 by 5.40 by 0.5 cm

(3.4 by 2.1 by 0.4 in.)

Power Requirement 500 mA typical

I/O Connector Cable with 9-pin D-Sub and 5-pin 

Combicon-style pluggable screw 

terminal for each port

Operating Environment

Component Temperature

Relative Humidity

0° to 55° C

10% to 90%, noncondensing

Storage Environment

Temperature

Relative Humidity

–20° to 70° C

5% to 90%, noncondensing

EMI FCC Class A Verified

Table D-3.  DeviceNet Port Characteristics for Bus-Powered Ports

Characteristic Specification

Power Requirement 10 to 30 V 40 mA typical

100 mA maximum

Isolation 500 VDC optical
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E
Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessary 

to help us solve your technical problems and a form you can use to comment on the product 

documentation. When you contact us, we need the information on the Technical Support Form and 

the configuration form, if your manual contains one, about your system configuration to answer your 

questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to quickly 

provide the information you need. Our electronic services include a bulletin board service, an FTP site, 

a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first try the 

electronic support systems. If the information available on these systems does not answer your 

questions, we offer fax and telephone support through our technical support centers, which are staffed 

by applications engineers. 

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of files 

and documents to answer most common customer questions. From these sites, you can also download 

the latest instrument drivers, updates, and example programs. For recorded instructions on how to use 

the bulletin board and FTP services and for BBS automated information, call 512 795 6990. You can 

access these services at:

United States: 512 794 5422

Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635 551422

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use 

your Internet address, such as joesmith@anywhere.com, as your password. The support files and 

documents are located in the /support directories.
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Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a wide 

range of technical information. You can access Fax-on-Demand from a touch-tone telephone at 

512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mail at the 

Internet address listed below. Remember to include your name, address, and phone number so we can 

contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technical 

support number for your country. If there is no National Instruments office in your country, contact 

the source from which you purchased your software to obtain support.

Country Telephone Fax

Australia 03 9879 5166 03 9879 6277

Austria 0662 45 79 90 0 0662 45 79 90 19

Belgium 02 757 00 20 02 757 03 11

Brazil 011 288 3336 011 288 8528

Canada (Ontario) 905 785 0085 905 785 0086

Canada (Quebec) 514 694 8521 514 694 4399

Denmark 45 76 26 00 45 76 26 02

Finland 09 725 725 11 09 725 725 55

France 01 48 14 24 24 01 48 14 24 14

Germany 089 741 31 30 089 714 60 35

Hong Kong 2645 3186 2686 8505

Israel 03 6120092 03 6120095

Italy 02 413091 02 41309215

Japan 03 5472 2970 03 5472 2977

Korea 02 596 7456 02 596 7455

Mexico 5 520 2635 5 520 3282

Netherlands 0348 433466 0348 430673

Norway 32 84 84 00 32 84 86 00

Singapore 2265886 2265887

Spain 91 640 0085 91 640 0533

Sweden 08 730 49 70 08 730 43 70

Switzerland 056 200 51 51 056 200 51 55

Taiwan 02 377 1200 02 737 4644

United Kingdom 01635 523545 01635 523154

United States 512 795 8248 512 794 5678



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and use 

the completed copy of this form as a reference for your current configuration. Completing this form 

accurately before contacting National Instruments for technical support helps our applications 

engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem, 

include the configuration forms from their user manuals. Include additional pages if necessary.

Name __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) __________________________________________

Computer brand ___________ Model ___________________Processor _____________________

Operating system (include version number) ____________________________________________

Clock speed ______MHz   RAM _____MB Display adapter __________________________

Mouse ___yes   ___no     Other adapters installed _______________________________________

Hard disk capacity _____MB Brand ________________________________________________

Instruments used _________________________________________________________________

_______________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration ___________________________________________________________________

National Instruments software product ___________________  Version  _____________________

Configuration ___________________________________________________________________

The problem is: __________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

List any error messages: ___________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

The following steps reproduce the problem: ___________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________



Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each item. 

Complete a new copy of this form each time you revise your software or hardware configuration, and 

use this form as a reference for your current configuration. Completing this form accurately before 

contacting National Instruments for technical support helps our applications engineers answer your 

questions more efficiently.

National Instruments Products

Information from NI-DNET Hardware Configuration Utility

Hardware type (such as PCI-CAN) __________________________________________________

Diagnostic Status ________________________________________________________________

Resources: Interrupt Request ___________________  Memory Range _____________________

Serial Number __________________________________________________________________

Hardware Revision ______________________________________________________________

NI-DNET Software Version (Help»About) ___________________________________________

Other Products

Programming Environment Information

Programming Language ___________________________________________________________

Compiler Vendor ________________________________________________________________

Compiler Version ________________________________________________________________

Application Information

LabVIEW, BridgeVIEW, LabWindows/CVI Application _________________________________

Win32 Application _______________________________________________________________

If Win 32, method of accessing DLL (link with language interface or direct entry?) ____________

______________________________________________________________________________



Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products. 

This information helps us provide quality products to meet your needs.

Title: Getting Started with Your CAN Hardware for DeviceNet and the 

NI-DNET™ Software for Windows NT

Edition Date: April 1998

Part Number: 321865A-01

Please comment on the completeness, clarity, and organization of the manual.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

Thank you for your help.

Name _________________________________________________________________________

Title __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

E-Mail Address __________________________________________________________________

Phone ( ___ ) __________________________  Fax ( ___ ) _______________________________

Mail to: Technical Publications Fax to: Technical Publications

National Instruments Corporation National Instruments Corporation

6504 Bridge Point Parkway 512 794 5678

Austin, Texas 78730-5039



© National Instruments Corporation G-1 Getting Started with DeviceNet for Windows NT

Glossary

Prefix Meanings Value

m- milli- 10–3

c- centi- 10–2

k- kilo- 103

M- mega- 106

° degrees

Ω ohms

% percent

A amperes

ANSI American National Standards Institute

applet program that can only be used within another application

b bits

B bytes

C Celsius

CAN Controller Area Network

change-of-state I/O Master/slave I/O connection which is similar to cyclic I/O, but data can be 

sent when a change in the data is detected

CiA CAN in Automation

cyclic I/O Master/slave I/O connection in which the slave (or master) sends data at a 

fixed interval

DC direct current

DLL dynamic link library

EMI electromagnetic interference

explicit messaging 

connection

General-purpose connection used for executing services on a particular 

object in a DeviceNet device
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FCC Federal Communications Commission

ft. feet

HMI human-machine interface

Hz hertz

IEEE Institute of Electrical and Electronic Engineers

in. inches

I/O input/output

m meters

MAC ID Media Access Control Layer Identifier

master/slave DeviceNet communication scheme in which a master device allocates 

connections to one or more slave devices, and those slave devices can only 

communicate with the master and not one another

PC personal computer

PCI peripheral component interconnect

PCMCIA Personal Computer Memory Card International Association

PLC Programmable Logic Control

polled I/O Master/slave I/O connection in which the master sends a poll command to 

a slave, then receives a poll response from that slave

RAM random-access memory

resource hardware settings used by National Instruments CAN hardware, including 

an interrupt request level (IRQ) and an 8 KB physical memory range (such 

as D0000 to D1FFF hex)

s seconds

SCADA supervisory control and data acquisition

strobed I/O Master/slave I/O connection in which the master broadcasts a single strobe 

command to all strobed slaves then receives a strobe response from each 

strobed slave

V volts

VDC volts direct current



Glossary

© National Instruments Corporation G-3 Getting Started with DeviceNet for Windows NT

VXI VME eXtensions for Instrumentation (bus)

W watts
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